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1-800-884-2555 or sales@avenza.com

Upgrade to the full version of MAPublisher and enjoy the
benefits of the following features and tools:

MAPublisher contains over 30 filters and tools not found 
in MAPublisher Lt.

* MAP Projection Tools
* MAP Data Collection Tools
* MAP Legend Tools
* MAP Feature Selection Tools
* MAP Vector Drawing Tools
* MAP Scale and Transformation Tools
* Scale and register raster images
* Create, Import and update external databases 

TMublisher
The NEW system for mapmakers
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to Geo-enable your website!
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MAPublisher Lt for Adobe Illustrator 
or Macromedia FreeHand system requirements
Macintosh Operating Systems:
• Power Macintosh (recommended) 

or Macintosh with 68040 (or greater) processor.

• Apple System Software version 7.1 
or greater.

•  Adobe Illustrator 7 or Macromedia FreeHand 7 (PowerPC only)

• 24 MB minimum of application RAM allocated 
to Adobe Illustrator / Macromedia FreeHand.

•  2 MB disk space for filters.

Windows Operating Systems:

• 486DX or higher (Pentium recommended).

• Windows 95 or Windows NT 
version 4 or greater.

•  Adobe Illustrator 7 or Macromedia FreeHand 7

• 24 MB minimum RAM 
(32 MB recommended).

•  2 MB disk space for filters.



Installing MAPublisher Lt

To install the new filters:
1. Insert the MAPublisher Lt CD. 

2. Find and double click the MAPublisher Lt  Installer/Setup.exe file to start the installation.

3. Follow the prompts to install the MAPublisher Lt plug-in filters/xtras in their respective folders.

You are now ready to launch Adobe Illustrator/Macromedia FreeHand.

Preparing to create a map in 
Adobe Illustrator / Macromedia FreeHand
The first step is to open and prepare your file by going through the following steps:

● open a new file

● set the document page -- as explained on page 7.

● show the necessary palettes -- Layors / Inspectors etc.

● alter the origin of the rulers -- 0,0 at the bottom left corner of the page is best.

● save the file

NOTE: A basic understanding of Adobe Illustrator/Macromedia FreeHand is assumed throughout this guide. If
you are not familiar with Adobe Illustrator or Macromedia FreeHand, you should go through the Adobe Illustrator/
Macromedia FreeHand tutorial prior to using MAPublisher Lt.



To create a new file:
1. Launch Adobe Illustrator/Macromedia FreeHand.

Adobe Illustrator/Macromedia FreeHand automatically opens a new file upon launching. It scans the Plug-
ins folder and activates the MAPublisher plug-in filters.

NOTE: The first time you run a MAPublisher filter you will be prompted to enter the registration key code
from the back of the diskette.

To set the document page:
1. Select File → Document Setup.

The Document Setup window appears.

2. Ensure that Ruler Units is set to Inches.

3. Enter page sizes in the Dimensions fields.

4. Click the radio button beside Tile imageable areas to ensure that the entire document will be
printed.

5. Click OK.
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You can import vector data into MAPublisher Lt by using the Import 
Filter/Xtra. This filter accepts the following file formats:

 

●

 

Arc/Info Generate

 

●

 

ArcView Shapefile

 

●

 

AutoCAD DXF

 

●

 

MapInfo mid/mif

 

●

 

USGS DLG

 

●

 

USGS SDTS



To import vector data:
1. Using the Paint Style palette set the stroke and fill.

2. Select Filter/Xtra → MAPLt Import→ Do Import.

The MAPublisher Import window appears for you to begin importing.

MAPUBLISHER LT IMPORT WINDOW



3. In the Conversion Parameters section, set the File Format to that of 
the file you want to import. Depending upon the file format you 
select, the list of available options changes under Feature Type.

4. In the Input and Output section, click Select next to the Map file 
field to access your desktop. This lets you specify the file you want 
to import. 

NOTE: For MapInfo files, select the mif file first and the 

File Format Feature Type

Arc/Info Generate Point, Line, Area

ArcView Shapefile n/a

AutoCAD DXF n/a

MapInfo mid/mif n/a

USGS DLG Lines, Areas, Both

USGS SDTS n/a



corresponding mid file will automatically appear in the Attribute field. 
For ArcView Shape files select the spatial file .shp and the corresponding 
attributes file .dbf will automatically appear.

MAPublisher automatically creates a new layer based on the name of the 
file(s) you are importing.

5. In the Input and Output section, enter a layer name in the New 
Layer field if you wish to change it.

NOTE: You can rename the layer here or later in the Adobe Illustrator 
Layers palette.

6. Click Defaults to calculate the exact scale and map anchor of the 
map to fit within your document size;
or
In the Scaling section, enter the scale and map anchor of the map 
you want to create.

 MAPublisher calculates the scale by looking at the current page size 
(width and height). It determines the extents of the map from the 
source data and calculates the exact scale required to fit the page 
size.

You can then customize your scale by rounding the scale to a 
number that suits your requirements.

NOTE: The map is made smaller by increasing the ratio (e.g., 1:50000 
is smaller than 1:25000); it is made bigger by decreasing the ratio (e.g., 
1:50000 produces a larger map than 1:100000).



7. Set the Page Anchors. The Page Anchor defines the placement of the 
map within the page allowing for margins and borders. If you want 
a border around your finished map (e.g., for aesthetics or a legend) 
then change the 0/0 positioning (e.g., to 1.5 x 1 inch). This will 
offset your map elements by that amount from the ruler origin.

NOTE: If you change your page anchors you may have to re-adjust your 
scale to make sure that the map still fits inside the page or border.

8. Set the Map Anchors. The Map Anchor represents the real world 
coordinates of the map anchor point (the minimum x and y 
coordinate values of your map). You may want to adjust these in 
special circumstances but it is not generally recommended.

9. Set the Angle field. In the Angle field you can change the 
orientation of the map from due north by specifying the angle in 
degrees that you want. For example, specifying -5.5 changes the map 
angle to 5.5° (clockwise).



10. Leave the Units in the default of your map file unless you want to 
change the units used for calculations.

11. Click the check box if you want to specify the Grain. This simplifies 
the line by reducing the number of intermediate points and results 
in a smoother line. It also makes the file size smaller thus reducing 
the amount of time to load the data and draw the map. 

NOTE: MAPublisher Lt always retains the first and last point of each 
line.

The default measurement of 0 (no grain) automatically appears for you 
to modify. The grain is specified in map units. For example, if you specify 
20 and your map units are in meters then MAPublisher will retain the 
points that are at least 20 meters apart.

12. Click OK when you are satisfied with your selections.

The imported map appears.



MAPublisher Lt uses the following menu options for working with GIS 
Mapping Tools:

MAP Select by Attribute
Choose this option if you want to define selection criteria for isolating 
specific features by attribute value.

MAP Select by Feature
Choose this option if you want a quick way to select all similar features 
on a layer.

Geographic Mapping Tools



MAPLt Select by Attribute
The MAPLt Select by Attribute menu option contains the following 
filters:

● Initial Selection

● Add to Selection

● Remove from Selection

● Select from Selection

All of these filters use the MAPublisher Select by Attribute screen to 
perform their specific functions; this screen lets you isolate selection 
criteria for a specific purpose.

For example, you would use this suite of filters if you are drawing a 
street map and want to identify one way streets. By working with 
various selection criteria you would be able to isolate the one way 
streets within a geographic area. 

To do this you build arithmetic expressions to define your selection 
criteria. You make your initial selection by using the Initial Selection 
filter and then use the other filters to add or subtract from this initial 
set of data.

SEE: Appendix 1- Selection Operators for an explanation of  Math and 
Logic operators.



INITIAL SELECTION

Use this filter to make your initial selection or to ignore any previous 
selections and to start again.

To select by attribute:
1. Select Filter/Xtras → MAPLt Select by Attribute → Initial Selection (Radio Button).

The MAPublisher Lt Select by Attribute window appears.

MAPUBLISHER LT SELECT BY ATTRIBUTE WINDOW

2. Set the Feature Type (i.e., area, line, point, or text). 

NOTE: You must set the feature type first and may set only one feature 
type per expression.



3. Set the Column (from the Table of Attribute Values).
From here you define your criteria by using the pulldown lists and 
buttons to write your expression.

NOTE: The pulldown list shows the unique values associated with the 
selected Column value.

4. Set the Value.

5. Click Insert when you have finished writing the expression.

The expression appears in the Selection Expression section. 

6. You can continue to build the expression by adding a logical 
operator (and, or, not) and inserting additional expressions 
(modifying the Column, comparison operator, or value).

Window Interface Description

Current Expression Shows the current section of the expression 
you are building

Clear Expression (button) Erases the expression so that you can start 
again

Selection Expression 
(box)

Displays the complete expression you are 
building

<<< (button) Lets you scroll to the front of the expression

>>> (button) Lets you scroll to the end of the expression



NOTE: Click on the button to quickly change the selection mode (Initial 
Selection, Add to Selection, Remove from Selection, Select from
Selection).

7. Click OK when you are satisfied with your selections.

Once you have used the Initial Selection filter, you can use the 
following filters:

● Add to Selection

● Remove from Selection

● Select from Selection

Display Number Selected 
(check box)

Displays the Selection Statistics window which 
shows the number of features currently 
selected

Ignore Case in Strings 
(check box)

Accepts both uppercase and lowercase 
characters as being the same

Window Interface Description



ADD TO SELECTION

Use this filter once you have selected a set of data (using Initial 
Selection) and now want to add to that selected data.

For example, if you used “a ” in your initial selection and now want to 
add “b” then you would use this filter so that the selected set that 
would remain would be “a +b.”

To select into a selected set of attributes:
1. Select Filter/Xtras → Select by Attribute → Add to Selection (Radio Button).

The MAPublisher Lt Select by Attribute filter window appears.

MAPUBLISHER LT SELECT BY ATTRIBUTE WINDOW



2. Set the Feature Type (i.e., area, line, point, or text). 

NOTE: You must set the feature type first and may set only one feature 
type per expression.

3. Set the Column (from the Table of Attribute Values). 
From here you define your selection criteria using the pulldown 
lists and buttons to write your expression. 

4. Click Insert when you have finished writing the expression.

The expression appears in the Selection Expression section.

5. Click OK when you are satisfied with your selections.



REMOVE FROM SELECTION

Use this filter once you have selected a set of data (using Initial 
Selection) and now want to extract from that selected data.

For example, if you used “a + b + c ” in your initial selection and now 
want only “a” to be removed then you would use this filter so that the 
selected set that would remain would be “b + c.”

To select into a selected set of attributes:
1. Select Filter/Xtras → MAPLt Select by Attribute → Remove from 

Selection (Radio Button).

The MAPublisher Lt Select by Attribute filter window appears.

MAPUBLISHER LT SELECT BY ATTRIBUTE WINDOW



2. Set the Feature Type (i.e., area, line, point, or text). 

NOTE: You must set the feature type first and may set only one feature 
type per expression.

3. Set the Column (from the Table of Attribute Values). 

From here you define your selection criteria by using the pulldown 
lists and buttons to write your expression. 

4. Click Insert when you have finished writing the expression.

The expression appears in the Selection Expression section.

5. Click on Check Box for Display Number Selected (SelStats menu 
appears in your work area) and/or Ignore Case in Strings (Refers to 
text case in your expression). 

6. Click OK when you are satisfied with your selections.

SelStats window – click on ‘A’ to select all features or ‘R’ to reverse 
the selection.



SELECT FROM SELECTION

Use this filter once you have selected a set of data (using Initial 
Selection) and now want to extract only a portion of that data.

For example, if you used “a + b + c” in your initial selection and now 
want only “a” then you would use this filter to extract “a” so that the 
selected set that would remain would be “a.”

To select from a selected set of attributes:
1. Select Filter/Xtras → MAPLt Select by Attribute → Select from Selection (Radio Button).

The MAPublisher Lt Select by Attribute filter window appears.

MAPUBLISHER SELECT BY ATTRIBUTE WINDOW

2. Set the Feature Type (i.e., area, line, point, or text). 

NOTE: You must set the feature type first and may set only one feature 
type per expression.



3. Set the Column (from the Table of Attribute Values). 

From here you define your selection criteria using the pulldown 
lists and buttons to write your expression. 

4. Click Insert when you have finished writing the expression.

The expression appears in the Selection Expression section.

5. Click OK when you are satisfied with your selections.



MAPLt Select by Feature
The MAP Lt Select by Feature menu option contains the following 
filters:

● Reverse Select

● Select All Areas

● Select All Lines

● Select All Points

● Select All Text

REVERSE SELECT

Use this filter once you have selected a subset of one or more features 
(i.e., area, point, line, text) within a layer to:

● deselect (unselect) what is currently selected, and then 

● select everything that had not been previously selected

You would use Reverse Select when you want to select features that do 
not meet a set of criteria. 

For example, if you have a drainage layer from which you want to 
select all the areas that are water bodies and not islands:

● use the filter Select By Attribute to select all areas that contain the 
word “island” 

● use Reverse Select to deselect the islands and select all the areas that 
are water bodies (and not islands)



To Reverse Select:
1. Select Filter/Xtras → MAPLt Select by Feature → Reverse Select.

All features on your current layer that were previously selected are now 
deselected and everything else of the same feature type is now selected.

SELECT ALL AREAS

Use this filter to select all areas on the current layer.

To select all areas:
1. Select Filter/Xtras → MAPLt Select by Feature → Select All Areas.

All areas on the current layer are now selected.

SELECT ALL LINES

Use this filter to select all lines on the current layer.

To select all lines:
1. Select Filter/Xtras → MAPLt Select by Feature → Select All Lines.

All lines on the current layer are now selected.



SELECT ALL POINTS

Use this filter to select all points on the current layer.

To select all points:
1. Select Filter/Xtras → MAPLt Select by Feature → Select All Points.

All points on the current layer are now selected.

SELECT ALL TEXT

Use this filter to select all text on the current layer.

To select all text:
1. Select Filter/Xtras → MAPLt Select by Feature → Select All Text.

All text on the current layer is now selected.



MAPublisherLt Selection Statistics
The Window -- MAPublisher Statistics --  SelStats menu option contains  
the following filter option buttons:

(R) Reverse Select

(A) Select All Areas/Lines/Points or Text

SAVE

RECALL

CLEAR

M or / M and / M Xor

REVERSE SELECT

Use this filter once you have selected a subset of one or more features 
(i.e., area, point, line, text) within a layer to:

- deselect (unselect) what is currently selected, and then 

select everything that had not been previously selected

You would use Reverse Select when you want to select features that do 
not meet a set of criteria. 

For example, if you have a drainage layer from which you want to 
select all the areas that are water bodies and not islands:

- use the filter Select By Attribute to select all areas that contain the 
word "island"

- use Reverse Select to deselect the islands and select all the areas that 
are water bodies (and not islands)



SELECTION STATISTICS BUTTONS

Use these buttons to manipulate feature selections on the current layer.

1.   Select Window -- MAPublisher Statistics -- SelStats -- SAVE

All features on the current layer are now SAVED in Memory.

2.   Select Window -- MAPublisher Statistics -- SelStats -- RECALL

All features on the current layer are RECALLED from Memory.

3.   Select Window -- MAPublisher Statistics -- SelStats -- CLEAR

All features on the current layer are CLEARED from Memory.

4.   Select Window -- MAPublisher Statistics -- SelStats -- M OR

All features on the current layer that are both in Memory AND are currently selected.

5.   Select Window -- MAPublisher Statistics -- SelStats -- M AND

All features common to both the currently selected set AND the set in memory.

6.   Select Window -- MAPublisher Statistics -- SelStats -- M X OR

All features excluding those common to both the currently selected set AND the set in memory.

NOTE: See http://www.avenza.com/freezone for a diagram explanation of the above.



MAPublisher Lt provides the definitive solution to the production of 
publication-quality maps by importing map files into Adobe Illustrator 
or Macromedia FreeHand, both are worldwide standard software in the 
graphics and printing industries for digital pre-press file management 
or Adobe Acrobat Portable Document Format (PDF). 

For high quality PostScript (EPS) output, you can set printing options, 
crop marks, trapping; create color separations, calibrate color monitor, 
convert custom colors to process, and set output resolution.

For PDF document management Avenza provides a MAPublisher PDF 
Export filter.  Export MAP documents with all database attributes intact 
to Adobe Acrobat PDF – Avenza’s JAMbuddy i and Q filters will display 
and enable querys on that database.

SEE ALSO: Adobe Print Publishing Guide. For Adobe Acrobat 
information: www.adobe.com

For links to data translators to convert to other GIS data formats see the 
Avenza web site:

● http://www.avenza.com/link2trans.html

MAPublisherLt Export



MAPUBLISHER EXPORT

Choose this option if you want to export map files using Adobe 
Acrobat PDF and JAMBuddy i and Q filters so that later you can view 
files in Adobe Acrobat Exchange or Reader, whether opened in 
Netscape Navigator or Microsoft Internet Explorer.

NOTE: Macromedia FreeHand users can export from Select Xtras → 
MAP Export  → MAPublisher PDF.

To export in MAPublisher PDF format from Adobe Illustrator:
1. Select File → Export.

The Export dialog box appears.

2. Enter the file name you want to save the file under, including the 
file extension”.pdf”.

3. Ensure that the file will be saved in the correct folder.

4. Set the file format to MAPublisher pdf.

5. Click Save when you are satisfied with your selections.



                                 
Tips
This chapter contains tips and techniques for working with 
MAPublisher Lt as well as troubleshooting tips for common problems.

PRODUCTIVITY TIPS

● Views

● Rotating Feature Text

● Shortcuts

IMPORTING FILES

● Data does not overlay as expected

● Importing large files is slow

● Vanishing data

● NAN (000)

● When a filter does not appear to work

● Missing data in an Arc/info generate file

● Data does not fit as expected

● Adjusting the map scale for multiple map sheets/tiles

Tips



                                    
BUILDING LEGENDS

● Building a color ramp legend

OTHER

● Map sheets or tiles that should be adjacent, but are not

● Attribute corruption

● Text style was set but the paint style changed

IF YOU NEED ADDITIONAL ANSWERS TO QUESTIONS

E-mail us at: 

● support@avenza.com. 

Please have your registration number handy and you’ll get prompt 
attention.

WISHLIST

Please let us know about filters or functions that you would like to see 
incorporated into future upgrades of MAPublisher:

E-mail us at: 

● wishlist@avenza.com. 

We want to satisfy your mapping needs.



           
Productivity Tips

VIEWS

You can display your document on–screen in a variety of ways using 
the View menu commands. For example, you can see a preview of the 
illustration as you edit, you can view only the outlines of your artwork, 
or you can preview selected parts of your artwork while displaying the 
rest as outlines.

ROTATING FEATURE TEXT

When rotating more than one text element, the Transform Each Palette 
menu usually provides the best results. When rotating a single text 
element, use manual rotation through the toolbox.



                             

y.
Importing Files
MAPublisher automatically imports files onto a new layer. This avoids 
corruption of data that can occur when different data structures are 
imported into a single layer.

DATA DOES NOT OVERLAY AS EXPECTED

The data imports, but two data sets that should overlay don’t. The most 
common scenario is when data set A is imported first and data set B 
second, data set A shows up but data set B does not appear or it is off 
in a corner as a tiny “blip.” 

When data set B is imported first and data set A second, data set B 
shows up but data set A does not appear or it is off in a corner as a tiny 
“blip.”

Check the data files for differing projections, zones, NADs or x/y shifts.

 SEE ALSO: Other later in this appendix.

IMPORTING LARGE FILES IS SLOW

Many GIS data files are large and when a series of such files is imported, 
you may find that the import filter starts to run more slowly. This is 
because scratch and memory allocations are being used up. The best 
solution is to periodically save your work, quit out of Adobe Illustrator/ 
Macromedia FreeHand and then restart. This will free up scratch memor



                
Also, you could reduce the minimum number of undos (since they all 
reside in memory).

A final suggestion is to increase your RAM allocation to Adobe 
Illustrator / Macromedia FreeHand is the only application open.

WARNING: If the files are very large you may simply run out of scratch 
memory, then you will have to purchase (and/or allocate) more RAM.

VANISHING DATA

If you imported some data and it appeared as selected, but when you 
deselected the data it seemed to vanish, here are a few things to check:

● You may have inadvertently pressed “cut” or the delete key. Check 
under Edit in the top menu bar, if the “Undo Clear” is available this 
means that you just deleted something. Select “Undo Clear,” and 
the data should return. 

● If you didn’t delete the data, another possibility is that because of 
the order of your layers, your data may be hidden. Try moving the 
layer in question to the top of the list of layers in the Layers palette, 
so that it is drawn in front of the other layers.

● Make sure that current layer is available for viewing in the Layers 
palette, by having a dot in the left hand column under the eye 
(visualization) and beside the layer.

● Check that you have colors for fill/stroke set in the Paint palette.



               
NAN (NOT A NUMBER)
This mysterious string may show up for the default scale value when 
you have selected Compute Defaults. Usually this will be accompanied 
by map anchors displayed as INF which stands for INFinite.These 
results indicate that the numbers in the file being imported are either 
so large or so small that the software cannot process the file. You 
should review your file through a text file editor (DLG, mid/mif and 
generate files are all ASCII).

MISSING DATA IN AN ARC/INFO GENERATE FILE 
If any of the cover–ids are equal to zero, the Arc/Info Ungenerate 
function ignores the associated graphics and does not include them in 
the generate file.

You can also create custom views of your document, retaining a 
particular magnification level, layering, and other viewing features for 
later retrieval. You can even display multiple views of a document at 
several different magnification levels simultaneously. 

NOTE: With any Macintosh application you can take advantage of 
viewing multiple windows while inside a single document.



DATA DOES NOT FIT AS EXPECTED

It is very important that you ensure that data used within a single 
mapped area have the same map projection. If different data sets for a 
geographic location have differing projections, the chances are high 
that they will not overlay on import. If you find that imported data 
from different sources does not fit as expected, it is usually due to 
dissimilar map projections. If the projections are known, you can ask  
your data provider to change all data to a common projection.

For more information about map projections there is a link on our 
glossary web page to the British Columbia Government Ministry of 
Environment tutorial on map projections:

● http://www.avenza.com/glossary.html 

ADJUSTING THE MAP SCALE FOR MULTIPLE MAP 
SHEETS/TILES

When importing multiple adjacent maps sheets/tiles, use the Compute 
Defaults on the tile that is most south and west (lower left). For USGS 
DLG files this is number “5”. Then, when rounding up the scale, 
consider the number and area of all the adjacent map tiles involved. 
For example, four similarly sized adjacent map tiles require that you 
double the Default Scale Value.



Building legends
Use the “Align” toolbox that is available under “Window” on the main 
menu to easily tidy up your legend information. 

BUILDING A COLOR-RAMP LEGEND 
You can enhance the look of your maps by using color ramps, rather 
than random colors, for your legends.

1. Build a vertical set of filled legend elements. 

2. Color the first (top) and last (bottom) elements with the two 
extreme end colors for the ramp. 

3. Marquee (select) the complete set of legend elements. 

4. Select Filters ® Colors ® Blend Vertically and the legend set colors 
will be blended between the two end extreme colors. 



Other

MAP SHEETS OR TILES THAT SHOULD BE ADJACENT, 
BUT ARE NOT

When importing adjacent maps sheets/tiles, do the Compute Defaults 
on the tile that is most south and west (lower left), to find the map 
anchor and then do not run Compute Defaults again. If you do reset 
the map anchor, the tiles very likely will display on top of one another 
or won’t line up.

If the adjacent sheets are in adjacent UTM zones, you will need to make 
sure that they have all been ”re–projected” into a common zone to 
display properly.

ATTRIBUTE CORRUPTION

The most likely cause of attribute corruption (other than the files being 
corrupted before you got them) is that you have put layers with 
differing attribute structures into a single layer. As a rule of thumb you 
should use one layer for each external file that you are importing. 

TEXT STYLE WAS SET BUT THE PAINT STYLE CHANGED

The paint style is automatically updated by Adobe Illustrator or 
Macromedia FreeHand to match the currently selected object. 



WHEN A FILTER DOES NOT APPEAR TO WORK

Make sure that you have highlighted the desired Layer in the Layers 
palette and that it is ready for editing and visualization. 

This means that black dots should appear in the left hand columns 
under both the eye (visualization) and under the pencil (locking and 
unlocking for adding and editing data). 
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Update portions of a layer or legend 
MAPublisher gives you the ability to update portions of a layer or 
legend by selecting one or more individual map objects based on 
attribute or color/pattern/symbol (Adobe Illustrator) and then 
reapplying a new color/symbol. There is no deleting and then re-
adding of the relevant map elements/layers. 

In practical terms this means that if you added a roads layer/element to 
your map and then realized that one of your roads line symbols didn’t 
look right, all you need to do is select for that class of road and change 
the symbol with the palettes. There is no need to delete, recode and 
redrape your roads.

Graphic Environme



           
Redrawing is automatic 
Redrawing of the affected map objects is clean and automatic and 
impacts only the redrawn portion and possibly some immediately 
adjacent portions of the map. This eliminates the need to wait while 
the entire map is re-drawn or refreshed. This applies to text as well as 
to vector data.

Broad selection of fonts 
You have a broad and flexible selection of text fonts, styles, sizes and 
enhancement features (e.g., haloing).

Postscript pattern fills 
You can use PostScript pattern fills and complex vector strokes. You 
can sample colors from images and apply them precisely to vector data. 

Complex color treatments
Even with complex colors you can quickly and accurately create color 
ramps with differing depths/intensity of 10%, 20%, etc. These can be 
set as individual colors on a palette or as a gradient across mapped 
features.

Speed drawing
You can easily turn on and off selected layers of a map to speed 
drawing. This can be done by turning off specified layers, and/or 

limiting the display of selected layers to simple vectors with all 
symbology removed.



            
Not only will this speed the handling of the map, it lets you easily use 
underlying vectors for reference with no distraction or distortion 
caused by mapping symbology.

Viewing “generalization” parameters
Viewing “generalization” parameters can be set at any size so that your 
text will be automatically symbolized by grayed areas for layout (or any 
other) purposes. This facilitates design and layout and speeds the 
drawing of highly detailed maps.

Proportional symbology
Symbology is accurately proportional to the map area you have 
“zoomed” into. What you see is what you get.

Accurate color
Colors displayed on screen accurately reflect the colors as they will be 
printed. Again, what you see is what you get. 

Better symbology
Better symbology (e.g., road treatments and cartographic symbols) is 
available than from traditional GIS software.

Actual size viewing
In addition to standard zooming and panning capabilities, you can 

view the details on a map at the actual size at which they will be 
plotted/printed. 



           
Saving views
You have the option of saving individual “views” to facilitate editing 
or viewing defined portions of the map. No more searching around for 
a particular area that you want to display. 

Rulers, guidelines and alignment tools
Border rulers with adjustable guidelines and multi-combination 
alignment tools are available for use in aligning map objects. 

Grouping and ungrouping
There is grouping and ungrouping functionality. When items are 
grouped you still retain the option of separately accessing, querying 
and otherwise working with the individual components of a map 
group. 

Store related objects
Individual but related map objects can be “stored” together by groups 
or by layers or both within the graphic file. This provides additional 
control and support in handling and organizing the map components. 

Paste in front or behind
When pasting map objects/elements, you have the option of deciding 
to paste the new object in ”front” or “behind” the copied elements at 
the time of pasting.



 

AutoCAD DXF

 

Computer Aided Design (CAD) is the modeling of physical systems on 
computers, allowing both interactive and automatic analysis of design 
variants, and the expression of designs in a form suitable for 
manufacturing.  MAPLt will import AutoCAD12 or earlier format.

To date, modeling has been done almost entirely with proprietary 
dedicated systems usable only for one form of design.

CAD systems have developed into general purpose tools that 
understand geometry.

A typical CAD system has a geometry processor with an attached 
database. Analysis and simulation sit on top of this core, embodied in 
a host of separate programs which intercommunicate, if at all, only by 
passing information through the database.

 

Appendix B
File Formats



 

MapInfo mid/mif files

 

The MapInfo Professional Reference manual states, “MapInfo 
Interchange Format (MIF) is an ASCII file format that fully describes a 
MapInfo database. Both graphic and tabular data are exported into MIF 
files. The graphic data is in a file with a “.mif” extension, and the 
tabular data is in a file with a “.mid” extension.” 

When exporting from MapInfo, you (or your data provider) should 
specify the type of file export to perform as being MapInfo Interchange 
Format MIF (default). The export facility will generate both the “.mif” 
and “.mid” files.

Mif files contain all the vector data and mid files contain all the 
attribute data. When you select for a mif file, the associated mid file is 
automatically added to the appropriate entry in the menu. Selecting a 
mid file instead of a mif file causes the import process to fail.With 
MapInfo, users often work with longitude and latitude (long/lat) map 
coordinates. But this tends to distort areas towards the Earth’s poles. 
Since you are actually creating a flat surface from a sphere, you want to 
do this with the least amount of distortion.

 

SEE ALSO:

 

 Appendix F - Map Projections for information about various 
map projections.

 

SEE ALSO: 

 

Appendix G - UTM Zones Table and Map for a table with 
Central Meridians, longitude ranges and zones for the UTM world grid.



 

Arc/Info Generate Files

 

Arc/Info Generate files are ASCII coordinate files created from Arc/Info 
coverages through the use of the Arc/Info Ungenerate function. 
Generate is a useful mechanism that allows you to transfer Arc/Info GIS 
data to MAPublisher Lt. These files contain the user/cover–ids for line, 
point or polygon features. If you have a unique numeric value or 
feature code that you wish to use in MAPublisher Lt, simply calculate 
the user/cover–id to that value or code. For example, if the cover is 
called lakes, use the Arc/Info command: Calculate Lakes–id = ‘your 
feature code’. Remember to do this before running the Ungenerate 
command. 

 

NOTE: 

 

If any of the cover–ids are equal to zero, the Ungenerate function 
ignores the associated graphics and excludes them from the generate file.



 

ArcView Shape Files

 

Arcview by E.S.R.I.  outputs Shape files.  All shape files are file  "triplets" 
with the  extensions *.dbf, *.shx, *.shx  If you are missing  any of these 
you will not be able to import. All three files must be available to 
MAPublisher Lt.

For example for a layer/cover named roads you should have: roads.shp, 
roads.dbf and roads.shx

 

NOTE:

 

 if you have to transfer these files from one computer and/or 
operating system, to another then you must *always* use binary ftp 
tranfer, or the files will be corrupted. We have found that you *can 
not* rely on the automatic transfer with all ftp utilities. Some do 
not *recognize* the  shape files as being binary and will transfer 
them as ASCII causing damage to the files.



 

USGS DLG and SDTS Files

 

Digital Line Graph (DLG) and Spatial Data Transfer Standard (SDTS) 
files are geographic data files provided by the United States Geological 
Survey (USGS). These data files include information about the USGS 
planimetric map base categories such as transportation, hydrography, 
contours (hypsography) and public land survey boundaries. 
MAPublisher currently imports the Optional distribution format which 
is usually in meters in the UTM coordinate system. This file format will 
have the extension “.opt”.

 

SEE ALSO:

 

 USGS web site home page: 

 

•

 

http://www.usgs.gov/ 
Many of the DLG files are large and when a series of such files is 
imported the import filter runs more slowly. This is because scratch 
and memory allocations are being used up. The best solution is to 
periodically save your work, and quit out of Adobe Illustrator and then 
restart. This will free up the scratch memory. Use the “Same as” option 
so that you do not have to re–enter your scaling parameters. The 
inherent geo–referencing of the layer data ensures that data added at 
any time will geographically match.



 

Major Attribute Codes United States Geological Survey, 
Digital Line Graph (DLG) File Format:

 

Major Code Base Category

 

020 Hypsography

050 Hydrography

070 Vegetative Surface Cover

080 Non–vegetative Features

090 Boundaries

150 Survey Control Markers

 

Transportation Systems

 

170 Roads and Trails

180 Railroads

190 Pipelines, Transmission Lines, and Miscellaneous 
Transportation Features

200 Manmade features

 

Nonbase Category

 

300 U.S. Public Land Survey System



 

Since the Internet is always changing with existing sites changing and 
new ones being added, refer to our web page for the most recent list of 
relevant Internet sites.

 

GIS 

 

USERS

 

For Geographic Information System (GIS) users, the appeal of graphics 
is strong and the increasing ability to discover and share GIS across the 
Internet is fascinating. 

The Internet offers a number of free–access GIS–related Universal 
Resource Locators (URLs), or sites, from which you can access map and 
information data sets. And the number is constantly growing. Hop on 
the Internet and discover a wealth of information.

 

G

 

ENERAL

 

 

 

GRAPHICS

 

 

 

USER

 

For the general graphics user, there’s general information about 
countries, states, and places; simple maps of areas (e.g., GIF, PS format); 
lists and maps of Internet resources (e.g., Gopher/WWW servers) in an 
area. 

 

Appendix C - 
Internet Sites



 

C

 

ARTOGRAPHERS

 

For cartographers and geography researchers, there are cartographic/
GIS base map files (e.g., USGS DEMOs, DLGs, TIGER); thematic data of 
a geographic nature (e.g., census data); and complete GIS data sets (e.g., 
Arc/Info export files).

These lists are readily available, and there is a comprehensive list of free 
data sites accessible from the MAPublisher Internet home page at:

 

●

 

http//www.avenza.com/

Download (File Transfer Protocol — FTP) these files to your hard drive. 
You can import the major file format types into Adobe Illustrator via 
MAPublisher, at which point you can manipulate the data to suit your 
needs.

 

F

 

REE

 

 US 

 

MAP

 

 

 

DATA

 

Department of the Interior – U.S. Geological Survey home page. This is 
the primary source for Digital Line Graph (DLG) files. A must–have 
resource is the U.S. Geological Survey Digital Format Standards manual 
published by USGS. 

 

●

 

http://www.usgs.gov/ – USGS Home page

 

●

 

http://nsdi.usgs.gov/nsdi/products/dlg.html – Digital products

 

●

 

http://www.usgs.gov/pubprod/index.html – Products and 
Publications Listings



 

CAST

 

The Centre for Advanced Spatial Technologies (CAST), University of 
Arkansas. 

 

●

 

http:// www.cast.uark.edu/ 

Planned free access on the ARKNet statewide network. Among its high–
tech offering, CAST maintains a catalog of Arkansas, U.S. national and 
global data — e.g., GIS data in areas of archaeology, agriculture and 
population are downloadable as GIF files across the Internet. 

Obtain a map of historical land coverage data. Obtain data sets 
including Environment, Prehistoric and Historic Climate 
Reconstruction, Historic Census, and Tabular databases.

 

GMDNCC

 

The Florida Growth Management Data Network Coordinating Council 
(GMDNCC). This web site can be found at: 

 

●

 

http://www.cs.fsu.edu/~fldata. 

The system provides access to Florida meta data for state, county, and 
local; data sets; and documents including text, image, spatial data files, 
etc. Spatial data files require GIS software (e.g., Arc/Info, MapInfo) to 
view.



 

T

 

HE

 

 G

 

EO

 

W

 

EB

 

 

 

SYSTEM

 

 Its mission is to provide a service which geographers, GIS users, and 
the general public can use to locate geographic information that has 
been made available on the Internet. The GeoWeb can be found by 
accessing:

 

●

 

 http://wings.buffalo.edu/geoweb/

 

EROS D

 

ATA

 

 C

 

ENTER

 

 

 

They will be providing FTP access to a variety of USGS digital data sets. 
Check out:

 

●

 

http://edcwww.cr.usgs.gov/doc/edchome/ndcdb/ndcdb.html

 

R

 

EASONABLY

 

 

 

PRICED

 

 

 

DATA

 

 

 

SETS

 

For vector data:

 

Cypress Geo–Resources at:

 

●

 

http://www.cyp.com/ 

 

For raster data:

 

Triathlon Mapping Corporation at 604/294–8861 or tmc@helix.net



 

C

 

OMPREHENSIVE

 

 

 

LIST

 

A comprehensive list of GIS sites is available at the following addresses:

 

●

 

ftp://gis.queensu.ca/pub/gis/docs/gissites.html

 

●

 

http://www2.ncsu.edu/bae/people/faculty/walker/hotlist/
geogis.html

 

●

 

http://www.hdm.com/gis3.html

 

●

 

http://web1.digital.net/~mapinfo/



 

MapInfo data sample (map of Toronto) was provided by DigiMap Data 
Services Inc., Toronto, Canada. The following definitions are excerpted 
from the Statistics Canada Catalogue of data products (1992):

 

C

 

ENSUS

 

 M

 

ETROPOLITAN

 

 A

 

REA

 

 (CMA)

 

The general concept of a census metropolitan area (CMA) is one of a 
very large urban area, together with adjacent urban and rural areas 
which have a high degree of economic and social integration with that 
urban area.

 

C

 

ENSUS

 

 T

 

RACT

 

 (CT)

 

The general concept of a census tract is that of a permanent, small 
urban neighborhood–like or rural community–like area established in 
large urban–centered regions with the help of local specialists 
interested in urban and social science research.

 

Appendix D - 
Data Sources



 

E

 

NUMERATION

 

 A

 

REA

 

 (EA)

 

An enumeration area (EA) is the geographic area canvassed by one 
census representative. 

 

O

 

RTHOPHOTO

 

 TIFF

 

This orthophoto sample used in the Quick Start Guide was provided by 
Triathlon Mapping Corporation. An orthophoto is a reconstructed 
image of an aerial photograph which has ground feature locations that 
meet standard map accuracies. The image is rectified using the most 
accurate, intensive cubic convolution algorithm, then registered to a 
digital elevation model. The image is thereby geo–referenced and can 
be used as an independent GIS layer or combined with other vector 
design files.



 

F

 

ACILITATES

 

 

 

QUERIES

 

A Geographic Information System (GIS) captures, stores, checks, 
analyzes, and displays geo-referenced data about the earth.

A GIS uses a database management system (DBMS) to store and link 
data that relates to the same geographic area. This facilitates the 
following types of queries:

 

●

 

what if…?

 

●

 

what is it?

 

●

 

where is it?

 

●

 

what spatial patterns exist?

 

●

 

what has changed since…?

 

Appendix E - 
GIS Backgrounder



 

A

 

NALYTICAL

 

 

 

TOOL

 

GIS systems are used by all levels of governments, academia, and 
businesses for such diverse purposes as monitoring environmental 
changes, access to timber, census reporting, municipal zoning, land 
records, mineral resource management, and mapping 
telecommunications and cable television utilities. 

In short, a GIS serves many needs and can be thought of as an 
analytical tool since it can be used to determine spatial relationships 
between geographic areas. A GIS contains a database linking spatial 
data with geographic information and lets you associate information 
with map features and to create new relationships based on those 
associations.

 

M

 

AP

 

 

 

FEATURES

 

A GIS stores two types of map information: spatial information (which 
describes the location and shape of geographic features) and 
descriptive information about those features. A GIS links these two 
types of data and maintains the spatial relationships between the map 
features.

Features are portrayed on two-dimensional maps as points, lines, and 
areas. For example, a map may contain a point representing locational 
information (such as telephone poles), lines representing linear 
features (such as roads), and areas representing geographic features 
(such as lakes).



 

Points

 

Usually represented by a symbol or label, a point is a discrete location 
which is usually too small to be identified as an area or line (e.g., an oil 
wellhead).

 

Lines

 

A line represents the linear shape of a map element which is too narrow 
to be an area (e.g., a contour line).

 

Areas

 

An area is a closed, bounded object which encompasses a 
homogeneous area (e.g., a park).

 

Spatial relationships

 

A map allows you to identify spatial relationships (e.g., a fire tower 
located inside a park) but it relies on you to derive this information 
from it.

 

Labels, symbols, and color

 

Map attributes are represented by labels, symbols, and color to make it 
easy to interpret (e.g., rivers are represented with blue lines of varying 
widths depending upon their size).



 

G

 

EOGRAPHIC

 

 

 

DATA

 

Since a GIS is a digital map database storing both spatial (graphic) and 
descriptive (tabular) information, the integration of this information 
provides an opportunity for analysis and communication.

Data is stored using the Cartesian system (x,y coordinate) as follows:

 

●

 

points are stored as a single x,y location 

 

●

 

lines are stored as a series of ordered x,y coordinates 

 

●

 

areas are stored as a string of x,y coordinates defining the lines that 
bound the area

Maps show real-world coordinates that have been projected onto a flat 
surface. 

 

SEE ALSO:

 

 Appendix  F - Map Projections for a summary of 
various map projections that are popular today.



 

T

 

OPOLOGY

 

Topology is a mathematical process for determining spatial 
relationships. It does this by expressing different spatial relationships 
as lists of features (e.g., an area is defined by the boundary lines).

The primary advantage of this type of data storage is that it is more 
efficient and permits faster processing of larger data sets.

 

Layers

 

Map features can be logically grouped into layers of related 
information. For example, a map could be layered by rivers, soils, 
mineral deposits, and municipality. This layering makes it easy to 
perform analyses that overlay geographic features and combine 
adjacent areas with similar characteristics. 

 

Attributes

 

Attributes store descriptive information and are stored as sets of 
characters (including numbers). An attribute is usually considered 
tabular data.



 

This information is published with permission from the U.S. Geological Survey.

 

A map projection is used to portray all or part of the round Earth on a 
flat surface. This cannot be done without some distortion. 

Every projection has its own advantages and disadvantages. There is no 
“best” projection. You must select the one that suits your needs, 
reducing the distortion of the most important features. A map can 
show one or more—but never all—of the following: true directions, 
true distances, true areas, true shapes.

Mapmakers and mathematicians have devised almost limitless ways to 
project the image of the globe onto paper. Scientists at the U.S. 
Geological Survey have designed projections for their specific needs—
such as Space Oblique Mercator, which allows mapping from satellites 
with little distortion.

 

NOTE:

 

 Refer to the following web page for more information on 
map projections:

 

●

 

http://www.utexas.edu/depts/grp/gcraft/notes/mapproj/
mapproj.html

 

Appendix F - 
Map Projections



 

This appendix presents information about the following projections 
which are supported by MAPublisher:

 

●

 

Albers Equal Area Conic

 

●

 

Azimuthal Equidistant

 

●

 

Bipolar Oblique Conic Conformal

 

●

 

Equidistant Conic (Simple Conic)

 

●

 

Gnomonic

 

●

 

Lambert Azimuthal Equal Area

 

●

 

Lambert Conformal Conic

 

●

 

Mercator

 

●

 

Miller Cylindrical

 

●

 

Oblique Mercator

 

●

 

Orthographic

 

●

 

Polyconic

 

●

 

Robinson

 

●

 

Sinusoidal Equal Area

 

●

 

Space Oblique Mercator

 

●

 

Stereographic

 

●

 

Transverse Mercator

 

SEE ALSO:

 

 Snyder, John P. 1987. Map Projections: A Working 
Manual. USGS Professional Paper 1395. Washington, DC. United 
States Printing office.

Muehreke, Phillip C. 1986. Map Use: Reading, Analysis, 
Interpretation, Madison, WI: JP Publications.



 

Albers Equal Area Conic

 

P

 

RESENTED

 

 

 

BY

 

 H. C. A

 

LBERS

 

 

 

IN

 

 1805. 

 

NOTE:

 

 USGS maps of the conterminous 48 states, if based on this 
projection, have standard parallels 29-1/2

 

°

 

N and 45-1/2

 

°

 

N. Such maps 
of Alaska use standard parallels 55

 

°

 

N and 65

 

°

 

N, and maps of Hawaii 
used standard parallels 8

 

°

 

N and 18

 

°

 

N.

 

Used…

 

by USGS for maps showing the conterminous United 
States (48 states) or large areas of the United States. It 
is well suited for large countries or other areas that are 
mainly east-west in extent and that require equal-area 
representation. Used for many thematic maps.
Maps showing adjacent areas can be joined at their 
edges only if they have the same standard parallels 
(parallels of no distortion) and the same scale.

 

All areas...

 

on the map are proportional to the same areas on the 
Earth.

 

Directions...

 

are reasonably accurate in limited regions.

 

Distances...

 

are true on both standard parallels. Maximum scale 
error is 1-1/4% on a map of conterminous States with 
standard parallels of 29-1/2

 

°

 

N and 45-1/2

 

°

 

N.

 

Scale...

 

is true 

 

only

 

 along standard parallels.

 

Map is not...

 

conformal, perspective, or equidistant.



 

Azimuthal Equidistant

 

 

 

Used…

 

by USGS in the 

 

National Atlas of the United States of 
America

 

 and for large-scale mapping of Micronesia. 
Useful for showing airline distances from the center 
point of projection. Useful for seismic and radio work. 
Oblique aspect used for atlas maps of continents and 
world maps for radio and aviation use. Polar aspect 
used for world maps, maps of polar hemispheres, and 
the United Nations emblem.

 

Distances and 
directions...

 

to 

 

all

 

 places are true 

 

only

 

 from the center point of 
projection. Distances are correct between points along 
straight lines though the center. All other distances are 
incorrect. Any straight line drawn though the center 
point is on a great circle.

 

Distortion...

 

of areas and shapes increases away from the center 
point.

 

Azimuthal

 

Mathematically projected on a plane tangent to any 
point on the globe. Polar aspect is tangent only at the 
pole.



 

Bipolar Oblique Conic Conformal

 

P

 

RESENTED

 

 

 

BY

 

 O. M. M

 

ILLER

 

 

 

AND

 

 W. A. B

 

RIESEMEISTER

 

 

 

IN

 

 1941.

 

Used…

 

to show one or both of the American continents. 
Outlines in the projection diagram represent areas 
shown on USGS Basement and Tectonic Maps of North 
America.

 

Scale...

 

is true along two lines (“transformed standard 
parallels”) that do not lie along any meridian or 
parallel. Scale is compressed between these lines and 
expanded beyond them. Scale is generally good but 
error is as much as 10% at the edge of the projection 
as used.

 

Graticule 
spacing...

 

increases away from the lines of true scale but retains 
the property of conformality except for a small 
deviation from conformality where the two conic 
projections join.

 

Map is...

 

conformal but 

 

not

 

 equal area, equidistant, or 
perspective.

 

Conic...

 

Mathematically based on two cones whose apexes are 
104

 

°

 

 apart and which conjecturally are obliquely 
secant to the globe along lines following the trend of 
North and South America.



 

Equidistant Conic (Simple Conic)

 

P

 

ROTOTYPE

 

 

 

BY

 

 P

 

TOLEMY

 

, 150 A.D. I

 

MPROVED

 

 

 

BY

 

 D

 

E

 

 

 

L

 

’I

 

SLE

 

 

 

ABOUT

 

 1745.

 

Used…

 

in atlases to show areas in the middle latitudes. Good 
for showing regions within a few degrees of latitude 
and lying on one side of the Equator. (For example, the 
Kavraisky No. 4 is an Equidistant Conic projection in 
which standard parallels are chosen to minimize overall 
error.)

 

Distances...

 

are true 

 

only

 

 along all meridians and along one or two 
standard parallels.

 

Directions, 
shapes and 
areas...

 

are reasonably accurate.

 

Distortion...

 

increases away from standard parallels.

 

Map is... not

 

 conformal, perspective, or equal area, but 
represents a compromise between Lambert Conformal 
Conic and Albers Equal Area Conic.

 

Conic...

 

Mathematically projected on a cone tangent at one 
parallel or conceptually secant at two parallels.



 

Gnomonic

 

C

 

ONSIDERED

 

 

 

TO

 

 

 

BE

 

 

 

THE

 

 

 

OLDEST

 

 

 

PROJECTION

 

. A

 

SCRIBED

 

 

 

TO

 

 T

 

HALES

 

, 

 

THE

 

 

 

FATHER

 

 

 

OF

 

 

 

ABSTRACT

 

 

 

GEOMETRY, WHO LIVED IN THE 6TH CENTURY B.C. 

Used… along with Mercator by some navigators to find the 
shortest path between two points. Used in seismic 
work because seismic waves tend to travel along great 
circles.

Directions... are true only from center point of projection. Any 
straight line drawn on the map is on a great circle.

Scale... increases very rapidly away from the center point.

Distortion... of shapes and areas increases away from the center 
point.

Map is... perspective (from the center of the Earth onto a 
tangent plane) but not conformal, equal area, or 
equidistant.

Azimuthal Geometrically projected on a plane. Point of projection 
is the center of a globe.



Lambert Azimuthal Equal Area
PRESENTED BY LAMBERT IN 1772. 

Used… by the USGS in its National Atlas and Circum-Pacific 
Map Series. Suited for regions extending equally in all 
direction from center points, such as Asia and the 
Pacific Ocean.

Areas... on the map are shown in true proportion to the same 
areas on the Earth. Quadrangles (bounded by two 
meridians and two parallels) at the same latitude are 
uniform in area.

Directions... are true only from the center point.

Scale... decreases gradually away from the center point.

Distortion... of shapes increases away from the center point. Any 
straight line drawn through the center point is on a 
great circle.

Map is... equal area but not conformal, perspective, or 
equidistant.

Azimuthal... Mathematically projected on a plane tangent to any 
point on the globe. Polar aspect is tangent only at the 
pole.



Lambert Conformal Conic
PRESENTED BY LAMBERT IN 1772. 

NOTE: For USGS Base Map series for the 48 conterminous States, standard parallels are 
33°N and 45°N (maximum scale error for map of 48 States is 2-1/2%). For USGS 
Topographic Map series (7.5- and 15-minute), standard parallels vary. For aeronautical 
charts of Alaska, they are 55°N and 65°N; for the National Atlas of Canada, they are 49°N 
and 77°N.

Used… by USGS for many 7.5- and 15-minute topographic 
maps and for the State Base Map series. Also used to 
show a country or region that is mainly east-west in 
extent. One of the most widely used map projections 
in the United States today. Looks like the Albers Equal 
Area Conic, but graticule spacings differ.

Conformality... is retained.

Distances... are true only along standard parallels, but are 
reasonably accurate elsewhere in limited regions.

Directions... are reasonably accurate.

Distortion... of shapes and areas is minimal at standard parallels, 
but increases away from them.

Shapes... on large-scale maps of small areas are essentially true.

Map is 
conformal...

but not perspective, equal area, or equidistant.

Conic... Mathematically projected on a cone conceptually 
secant at two standard parallels.



Mercator
PRESENTED BY MERCATOR IN 1569.

Used... for navigation or maps of equatorial regions. Any 
straight line on a map is a rhumb line (line of constant 
direction).

Directions... along a rhumb line are true between any two points on 
a map, but a rhumb line usually is not the shortest 
distance between points. (Sometimes used with 
Gnomonic map on which any straight line is on a great 
circle and shows the shortest path between two 
points.)

Distances... are true only along the Equator, but are reasonably 
correct within 15° of the Equator; special scales can be 
used to measure distances along other parallels. Two 
particular parallels can be made correct in scale instead 
of the Equator.

Areas and 
shapes...

of large areas are distorted.

Distortion... increases away from the Equator and is extreme in 
polar regions.

The map is 
conformal...

in that angles and shapes within any small area (such 
as that shown by a USGS topographic map) are 
essentially true.



cont’d

The map is... not perspective, equal area, or equidistant.
The Equator and other parallels are straight lines 
(spacing increases toward poles) and meet meridians 
(equally spaced straight lines) at right angles. Poles are 
not shown.

Cylindrical... Mathematically projected on a cylinder tangent to the 
Equator. (Cylinder may also be secant.)



Miller Cylindrical
 PRESENTED BY O.M. MILLER IN 1942.

Used… to represent the entire Earth in a rectangular frame.
This is popular for world maps. It looks like a Mercator 
but is not useful for navigation. It shows the poles as 
straight lines.

Avoids... some of the scale exaggerations of the Mercator but 
shows neither shapes nor areas without distortion.

Directions... are true only along the Equator.

Distances... are true only along the Equator.

Distortion… of distances, areas, and shapes is extreme in high 
latitudes.

The map is 
not...

equal area, equidistant, conformal or perspective.

Cylindrical Mathematically projected onto a cylinder tangent at 
the Equator.



Oblique Mercator
 DEVELOPED IN 1900-50 BY ROSENMUND, LABORDE, HOTINE ET AL.

Used… to show regions along a great circle other than the 
Equator or a meridian, that is, having their general extent 
oblique to the Equator. This kind of map can be made to 
show as a straight line the shortest distance between any 
two preselected points along the selected great circle.

Distances… are true only along the great circle (the line of tangency 
for this projection), or along two lines parallel to it. 
Distances, directions, areas, and shapes are fairly 
accurate within 15° of the great circle.

Distortion… of areas, distances and shapes increases away from the 
great circle. It is excessive toward the edges of a world 
map except near the path of the great circle.

This map is 
conformal…

but not perspective, equal area, or equidistant. Rhumb 
lines are curved.

Graticule 
spacing…

increases away from the great circle but conformality is 
retained. Both poles can be shown. Equator and other 
parallels are complex curves concave toward nearest 
pole. Two meridians 180° apart are straight lines; all 
others are complex curves concave toward the great 
circle.

Cylindrical Mathematically projected on a cylinder tangent, (or 
secant) along any great circle but the Equator or 
meridian. Directions, distances, and areas are reasonably 
accurate only within 15° of the line of tangency.



Orthographic
THE ORTHOGRAPHIC PROJECTION WAS KNOWN TO EGYPTIANS AND GREEKS 
2,000 YEARS AGO. 

Used… for perspective views of the Earth, Moon, and other 
planets. The Earth appears as it would on a 
photograph from deep space. Used by USGS in the 
National Atlas of the United States of America.

Directions... are true only from the center point of projection.

Scale... decreases along all lines radiating from the center 
point of projection. Any straight line through the 
center point is a great circle.

Areas and 
shapes...

are distorted by perspective; distortion increases away 
from the center point.

Map is... perspective but not conformal or equal area.

Distances... in the polar aspect are true along the Equator and all 
other parallels.

Azimuthal Geometrically projected onto a plane. Point of 
projection is at infinity.



Polyconic
ORIGINATED ABOUT 1820 BY HASSLER.

Used… almost exclusively for large-scale mapping in the 
United States until the 1950s. Now nearly obsolete, 
and no longer used by USGS for new plotting in its 
Topographic Map series. Best suited for areas with a 
north-south orientation.

Directions, 
distances, 
shapes and 
areas...

are true only along the central meridian.

Distortion... increases away from the central meridian.

Map is... a compromise of many properties. It is not conformal, 
perspective, or equal area.

Conic... Mathematically based on an infinite number of cones 
tangent to an infinite number of parallels.



Robinson
 PRESENTED BY ARTHUR H. ROBINSON IN 1963.

Uses… tabular coordinates rather than mathematical formulas 
to make the world “look right.” Better balance of size 
and shape of high-latitude lands than in Mercator, Van 
der Grinten, or Mollweide. Soviet Union, Canada, and 
Greenland are truer to size, but Greenland is 
compressed.

Directions... are true along all parallels and along the central 
meridian.

Distances... are constant along the Equator and other parallels, but 
scales vary.

Scale... is true along 38° N and S, constant along any given 
parallel. This is the same along N and S parallels that 
are the same distance from the Equator.

Distortion… All points have some. Distortion is very low along the 
Equator and within 45° of center. Distortion is greatest 
near the poles.

The map is... not conformal, equal area, equidistant, or perspective.

Pseudo-
cylindrical

or orthophanic (“right appearing”) projection.



Sinusoidal Equal Area
USED BY COSSIN AND HONDIUS, BEGINNING IN 1570. ALSO CALLED THE 
SANSON-FLAMSTEED. 

Used… frequently in atlases to show distribution patterns. 
Used by the USGS to show prospective hydro carbon 
provinces and sedimentary basins of the world. Has 
been used for maps of Africa, South America, and other 
large areas that are mainly north-south in extent.
An easily plotted equal-area projection for world maps. 
May have a single central meridian or, in interrupted 
form, several central meridians.

Graticule 
spacing...

retains property of equivalence of area.

Areas... on a map are proportional to the same areas on the 
Earth.

Distances... are correct along all parallels and the central 
meridian(s).

Shapes... are increasingly distorted away from the central 
meridian(s) and near the poles.

The map is... not conformal, perspective, or equidistant.

Pseudo-
cylindrical

Mathematically based on a cylinder tangent to the 
Equator.



 Space Oblique Mercator
DEVELOPED IN 1973-79 BY A.P. COLVOCORESSES, J.P SNYDER, AND J.L. 
JUNKINS.

Used… in Landsat images because there is no distortion along 
the curved groundtrack under the satellite. Such a 
projection is needed for the continuous mapping of 
satellite images, but it is useful only for a relatively 
narrow band along the groundtrack. Space Oblique 
Mercator maps show a satellite’s groundtrack as a 
curved line that is continuously true to scale as orbiting 
continues. The extent of the map is defined by the 
orbit of the satellite.

This map is 
conformal…

especially in the region of satellite scanning.



Stereographic
DATES FROM 2ND CENTURY B.C. ASCRIBED TO HIPPARCHUS. 

Used… by USGS for maps of Antarctica and American 
Geographical Society for Arctic and Antarctic maps. 
May be used to map large continent-sized areas of 
similar extent in all directions. Used in geophysics to 
solve spherical geometry problems. Polar aspects used 
for topographic maps and charts for navigating in 
latitudes above 80°.

Directions... are true only from center point of projection.

Scale... increases away from the center point. Any straight line 
through the center point is a great circle.

Distortion... of areas and large shapes increases away from the 
center point.

Map is... conformal and perspective but not equal area or 
equidistant.

Azimuthal Geometrically projected on a plane. Point of projection 
is at the surface of the globe opposite the point of 
tangency.



Transverse Mercator
 PRESENTED BY LAMBERT IN 1772.

Used… by USGS for many quadrangle maps at scales from 
1:24,000 to 1:250,000; such maps can be joined at 
their edges only if they are in the same zone with one 
central meridian. 
Also used for mapping large areas that are mainly 
north-south in extent.

Distances… are true only along the central meridian selected by 
the mapmaker or else along two lines parallel to it, but 
all distances, directions, shapes, and areas are 
reasonably accurate within 15° of the central meridian.

Distortion… of distances, directions, and size of areas increases 
rapidly outside the 15° band.

This map is 
conformal,…

shapes and angles within any small area (such as that 
shown by a USGS topographic map) are essentially 
true.

Graticule 
spacing…

increases away from the central meridian. The Equator 
is straight. Other parallels are complex curves concave 
toward the nearest pole. The central meridian and 
each meridian 90° from it are straight. Other meridians 
are complex curves concave toward central meridian.

Cylindrical Mathematically projected on cylinder tangent to a 
meridian. (Cylinder may also be secant.)



 

All values are in full degrees east (E) and west (W) of Greenwich (o degrees).

 

Central Range in Central Range in
Zone Meridian Longitude Zone Meridian Longitude

 

1 177W 180W-174W 31 3E 0 - 6E
2 171W 174W-168W 32 9E 6E- 12E
3 165W 168W-162W 33 15E 12E- 18E
4 159W 162W-156W 34 21E 18E- 24E
5 153W 156W-150W 35 27E 24E- 30E
6 147W 150W-144W 36 33E 30E- 36E
7 141W 144W-138W 37 39E 36E- 42E
8 135W 138W-132W 38 45E 42E- 48E
9 129W 132W-126W 39 51E 48E- 54E
10 123W 126W-120W 40 57E 54E- 60E
11 117W 120W-114W 41 63E 60E- 66E
12 111W 114W-108W 42 69E 66E- 72E
13 105W 108W-102W 43 75E 72E- 78E
14 99W 102W- 96W 44 81E 78E- 84E
15 93W 96W- 90W 45 87E 84E- 90E
16 87W 90W- 84W 46 93E 90E- 96E
17 81W 84W- 78W 47 99E 96E-102E
18 75W 78W- 72W 48 105E 102E-108E
19 69W 72W- 66W 49 111E 108E-114E
20 63W 66W- 60W 50 117E 114E-120E
21 57W 60W- 54W 51 123E 120E-126E
22 51W 54W- 48W 52 129E 126E-132E
23 45W 48W- 42W 53 135E 132E-138E
24 39W 42W- 36W 54 141E 138E-144E
25 33W 36W- 30W 55 147E 144E-150E
26 27W 30W- 24W 56 153E 150E-156E
27 21W 24W- 18W 57 159E 156E-162E
28 15W 18W- 12W 58 165E 162E-168E
29 9W 12W-  6W 59 171E 168E-174E
30 3W 6W - 0 60 177E 174E-180E
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World UTM Zones
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60



 

The U.S. Geological Survey offers many different maps:

 

●

 

Antarctic

 

●

 

Geologic

 

●

 

Hydrologic

 

●

 

Land use

 

●

 

National Atlas

 

●

 

Photoimage

 

●

 

Planets and Moons

 

●

 

Satellite image

 

●

 

Special maps

 

●

 

Topographic

 

●

 

Topographic-Bathymetric

 

Appendix H - 
USGS Maps



 

Antarctic Maps

 

Antarctic maps are available in four different scales.

 

1:250,000

 

A topographic reconnaissance and a geologic reconnaissance series at 
this scale has contour intervals of 200 meters and show bathymetric 
information for coastal areas. The topographic series is the primary 
map source for the planning, logistic support, and multidisciplinary 
investigations of the U.S. Antarctic Research Program.

 

1:500,000

 

Three series of maps — topographic reconnaissance shaded-relief, 
satellite image, and sketch — are published at this scale. The satellite 
imagery was recorded by NASA’s Landsat.

 

1:1,000,000

 

Topographic maps and Landsat maps are published at this scale. 
Topographic maps in the International Map of the World (IMW) 
format have contours at 100, 300, or 500 meters.

 

1:2,188,800

 

A reconnaissance sketch and topographic map of the Ross Ice Shelf at 
this scale was made in support of the Ross Ice Shelf Geophysical and 
Glaciological Program.



 

Geologic Maps

 

The USGS makes many kinds of geologic maps as a part of a continuing 
program to fulfill one of its missions: to examine the geological 
structure, mineral resources, and products of the national domain.

USGS maps that portray the geology of regions or local areas are 
available for nearly 50% of the United States.

 

Hydrologic Maps

 

Hydrologic Investigations Atlases (HA Series) are either black-and-
white or multicolor maps showing a wide range of water-resources 
information, such as depth to ground water, floods, irrigated acreage, 
producing aquifers, availability of water on Indian lands, surface-water 
discharge to the oceans, chemical or mineral content of water, surface 
impoundments, and water temperature.

Flood-prone area maps (scale of 1:24,000) are available by quadrangle 
name, from the Water Resources Division District Office in the State of 
interest.



 

Land Use Maps

 

Land use refers to human uses of the land (for example, for housing 
and industry). Land cover describes the vegetation, water, natural 
surfaces, and construction on the land surface. Standard base map 
features include boundaries, cities and towns, railroads, roads and 
highways, rivers and lakes — but no contours.

Land use and land cover maps are available for most of the United 
States.

Land use and land cover data are shown on USGS base maps at a scale 
of 1:100,000 for a few maps in Western States or at 1:250,000 (most 
maps).

 

National Atlas Maps

 

The 

 

National Atlas of the United States of America

 

 (1970) contains 765 
maps and charts on 335 pages. This Atlas is now out of print, but can 
be found in many libraries.

Separate sheets of selected reference maps and thematic maps from the 
Atlas are available from the USGS. Some of the sheets have been updated.



 

Photoimage Maps

 

O

 

RTHOPHOTOMAPS

 

Orthophotomaps are multicolored, distortion-free, photographic 
image maps. They show subtle topographic detail in areas of very low 
relief, such as marshlands and coastal zones.

They are produced in standard 7.5 minute quadrangle format from 
aerial photographs. Scale of 1:24,000 or 1:25,000.

 

O

 

RTHOPHOTOQUADS

 

Orthophotoquads are multicolored, distortion-free, photographic 
images maps. They have no contours, minimal cartographic treatment, 
and only a few names and symbols.

Orthophotoquads are available for selected areas along the east coast of 
the United States.

 

B

 

ORDER

 

 M

 

APS

 

The border maps are natural color photoimage maps. They are 
available for the U.S.-Mexico border and the U.S.-Canada border.



 

Planets and Moons

 

In 1960, the USGS established an astrogeology program on behalf of 
NASA to support lunar and planetary exploration. A prime activity of 
the program is the systematic mapping of the stratigraphy and 
structure of the Moon, Mars, Venus, Mercury, and the moons of the 
outer planets.

Many USGS maps of the Moon, Mars, Mercury, Venus, and the moons 
of Jupiter and Saturn are now available for purchase by the public.

The maps include geologic, topographic, photomosaic, and shaded-
relief maps. The scales, projections and sheet sizes vary widely.



 

Satellite Image Maps

 

Satellite image maps are multicolor or black-and-white photograph-
like maps made from data collected by Earth resources satellites. They 
are a diverse group of experimental maps printed in a standard edition 
and in a variety of scales and sizes. Many standard editions have 
topographic maps printed on the reverse side.

Most image maps are printed to simulate color-infrared photography 
by combining imagery that was scanned in red, green, and infrared 
wave lengths of light.

On color-infrared imagery, healthy vegetation appears in shades of red. 
Unhealthy vegetation appears in shades of pink, blue, or white. Clear 
water appears dark blue or black. Sediment laden water takes on a light-
blue tone. Most cultural features appear as a steely blue-gray.

Satellite images are available for selected areas in about half of the 
States and such areas as Antarctica, the Bahamas, and Iceland.



 

Special Maps

 

A wide variety of special maps are available for purchase from the 
USGS:

 

●

 

Geologic Map of the United States

 

●

 

Basement Rock Map of the United States — Exclusive of Alaska and 
Hawaii

 

●

 

Coal Fields of the United States

 

●

 

World Seismicity Map

 

●

 

Generalized Tectonic Map of North America

 

●

 

Surface Water and Related Land Resources Development in the 
United States and Puerto Rico

Many other special USGS maps are published from time to time.

The USGS has also published several planimetric maps of the United 
States, North America, and the World. Most of these maps show 
political boundaries, major cities and capitals, and many rivers and 
lakes.



 

Topographic Maps

 

Most USGS topographic maps use brown contours to show the shape 
and elevation of the terrain. Elevations are usually shown in feet, but 
on some maps they are in meters. Contour intervals vary, depending 
mainly on the scale of the map and type of terrain. The maps show and 
name prominent natural and cultural (man-made) features.

 

7.5-

 

MINUTE

 

 

 

MAPS

 

The best known USGS maps are those of the 7.5-minute, 1:24,000-scale 
quadrangle series. On such maps, 1 inch = 2,000 feet. The scale of these 
maps is used for areas where much detail must be shown.

 

15-

 

MINUTE

 

 

 

MAPS

 

From 1910 to about 1950, maps showing an area within 15 minutes of 
latitude and longitude were the USGS standard for topographic 
coverage of the United States. These maps were at a scale of 1:62,500 
(1 inch = about 1mile) and are still available. Features shown on these 
maps are similar to those on 7.5-minute maps, but some detail is 
omitted or generalized at the smaller scale.

 

U.S. 1:100,000-

 

SCALE

 

 

 

SERIES

 

Much of the United States is covered by 30- by 60-minute quadrangle 
maps at a scale of 1:100,000. Most of these maps are derived from 
1:24,000-scale maps, but they show distances and contour intervals in 
meters. Contours are at intervals of 5, 10, 20, or 50 meters depending 
on terrain relief.



 

C

 

OUNTY

 

 

 

MAP

 

 

 

SERIES

 

A county map may consist of one or more sheets, depending on the size 
of the county. County maps are available in scales of 1:50,000 and 
1:100,000.

 

U.S. 1:250,000-

 

SCALE

 

 

 

SERIES

 

Maps in the 1:250,000-scale (1 inch = about 4 miles) series are available 
for the entire United States. They were originated by the U.S. Army 
Map Service during the 1950s, but are now maintained by the USGS.

This series serves as base maps for aeronautical charts and geologic 
maps, for geographic reference, and in planning regional land use, 
transportation, and utility systems.

 

S

 

TATE

 

 

 

MAP

 

 

 

SERIES

 

The State maps in this series are usually published in three separate 
editions: base map, highway and contour map, and shaded-relief map. 
Most are at a scale of 1:500,000. The features shown are limited to areas 
within the State. No areas adjoining States are shown except for 
shorelines and other water areas that form State boundaries.



 

U.S. 1:1,000,000-

 

SCALE

 

 

 

SERIES

 

This series of topographic maps has been discontinued by the USGS 
and will not be reprinted when the existing stock is depleted.

The ground area shown ranges from 73,734 to 122,066 square miles 
(123,000 to 204,000 square kilometers). The maps show principal cities 
and towns, railroads, and political boundaries in black; roads in red; 
water features in blue; and topography in brown contour lines and 
gradient tints.

 

N

 

ATIONAL

 

 

 

PARK

 

 

 

MAP

 

 

 

SERIES

 

Each of these topographic maps, some of them with shaded relief, 
feature a national park, national monument, or national historic site at 
a range of scales. The maps are much like the standard quadrangle 
maps at the same scale, but they highlight recreational features.

 

S

 

HADED

 

-

 

RELIEF

 

 

 

MAPS

 

USGS publishes shaded-relief editions of certain topographic maps to 
accentuate physiographic features of special interest, and for some 
State, Antarctic, and national park maps. These maps use shaded relief, 
as well as contour lines, to represent the shape of the terrain.



 

Topographic-Bathymetric Maps

 

These USGS maps show in one format and one edition the data for a 
land-water area previously shown separately as a topographic map and 
a bathymetric map.

On topographic-bathymetric maps, contour lines show elevations of 
the land areas above sea level, and isobaths (depth contours) show the 
form of the land below the water surface.

Some bathymetric maps show magnetic and gravity data in addition to 
water depths.

Because coastal zones include both land and water, maps of such areas 
must include both topographic and bathymetric data. To produce 
these coastal maps, the National Ocean Service provides bathymetric 
data to be added to USGS topographic maps.

The combined map serves the needs of oceanographers, marine 
geologists, land use planners, physical scientists, conservationists, and 
others having an interest in management of the coastal zone, the 
wetlands, and the offshore environment.



 

M

 

ATH

 

 O

 

PERATORS

 

Window Interface Description

 

== Equal to for exact matches

!= Not equal to for dissimilar matches

> Greater than for values larger than the selected value

>= Greater than or equal 
to

for values that are larger than or equal to the 
selected value

< Less than for values less than the selected value

<= Less than or equal to for values that are less than or equal to the selected 
value

between: >a and < b            for values that are greater than “a” 

 

and

 

 also less 
than “b”

between: >=a and < b           for values that are greater than or equal to “a” 

 

and

 

 
are also less than “b”

between: >a and <=b           for the values that are greater than “a” 

 

and

 

 less 
than or equal to “b”

 

Appendix I - 
Selection Operators



 

between: >=a and <=b         for the values that are greater than or equal to “a” 

 

and

 

 less than or equal to “b”

CN (Contains) use to search for specific strings or sub-strings 
within a column (e.g., find all drainage features that 
contain the word 

 

Creek

 

)

 

Window Interface Description



 

L

 

OGIC

 

 O

 

PERATORS

 

Operator Example Result

 

AND Street == Main St AND 
Street == York St

not as expected; there are 

 

no

 

 
streets that are named both Main 
and York

AND Street == Main St AND 
Road Class == two lane

as expected; there 

 

are

 

 portions of 
Main Street that are two lanes

OR Street = =Main St OR 
Road Class == two lane

more than expected; results give 
streets that are 

 

either

 

 named 
Main St 

 

or

 

 are two lane 

 

and

 

 both

OR Street == Main St OR 
Street == York St

as expected; results give streets 
that are named Main 

 

and

 

 York

NOT Street == Main St W AND 
NOT Street == Main St

not as expected; the second 
arguments invalidates the first 
argument

NOT Street == Main St 
AND NOT Street == Main 
St W

as expected; results give segments 
of Main Street that are 

 

not

 

 Main 
St W



 

Glossary

 

If you have difficulty with some of the GIS terminology used, you can 
access the following for more information:

 

●

 

http://www.env.gov.bc.ca/gis/glosstext.html 

 

●

 

http://www.geo.ed.ac.uk/root/agidict/html/welcome.html 

 

●

 

http://www.avenza.com/glossary.html 

 

Accuracy

 

The closeness of results of observations, 
computations or estimates to the true values or the 
values accepted as being true. Accuracy relates to 
the exactness of the result, and is distinguished 
from precision which relates to the exactness of 
the operation by which the result is obtained. 

 

AGI 

 

Association for Geographic Information.

 

Algorithm

 

A set of rules for solving a problem. 

 

ASCII

 

American Standard Code for Information 
Interchange, a widely used industry standard 
code for exchanging alphanumeric codes in 
terms of bit–signatures.

 

Glossary



 

ANSI 

 

American National Standards Institute, an 
association formed by the American Government 
and industry to produce and disseminate widely 
used industrial standards.

 

Analog 
(or analogue) 

 

A continuously varying electronic signal; also 
refers to traditional paper mapping products and 
aerial photographs.

 

Annotation

 

The explanatory or descriptive alphanumeric text 
or labels on a map (or artwork), such as street or 
place name. 

 

Application

 

A set of computer programs designed for a 
specific task.

 

Arc

 

A line/vector defined by a series of points (a string 
of x,y coordinates).

 

Area

 

A bounded continuous two dimensional object 
which may or may not include its boundary. 
Usually defined in terms of an external polygon or 
in terms of a set of grid cells. A fundamental unit of 
geographical information. See polygon.

 

Aspect

 

Individual azimuthal map projections are divided 
into three aspects: the polar aspect which is 
tangent at the pole, the equatorial aspect which is 
tangent at the Equator, and the oblique aspect 
which is tangent anywhere else. (The word 
“aspect” has replaced the word “case” in modern 
cartographic literature.)



 

Attribute

 

Non–graphic alphanumeric textual information 
associated with a point, line, or area element in a 
GIS data set; tabular data associated with 
geographic features.

 

Azimuth

 

The angle measured in degrees between a base 
line radiating from a center point and another line 
radiating from the same point. Normally, the base 
line points North, and degrees are measured 
clockwise from the base line.

 

Bit map

 

A grid of small squares, cells or pixels stored in 
memory and used to generate an image.

 

Boolean

 

There are two types of values: true and false. These 
are usually represented by true/false or yes/no.

 

CAD(D)

 

Computer–Aided Drafting (Design).

 

Cadastral

 

Related to records of land tenure, often 
parcel based.

 

Cartography

 

The organization and communication of 
geographically related information in either 
graphic or digital form. It can include all stages 
from data acquisition to presentation and use. 

 

CAST 

 

Centre for Advanced Spatial Technologies, 
University of Arkansas.

 

Cell

 

The basic element of spatial information in a 
raster image.

 

Clipping

 

A graphic process of cutting lines and symbols off 
the edge of a display area.



 

Color Ramp

 

A graduated range of colors between two extreme 
color selections.

 

Conformality

 

A map projection is conformal when at any point 
the scale is the same in every direction. Therefore, 
meridians and parallels intersect at right angles 
and the shapes of very small areas and angles with 
very short sides are preserved. The size of most 
areas, however, is distorted.

 

Contour

 

A line connecting points of equal elevation.

 

Curvature

 

The amount of curve in line as defined by a series 
of points.

 

Data model

 

An abstraction of the real world which 
incorporates only those properties thought to be 
relevant to the application at hand. The data 
model would normally define specific groups of 
entities, and their attributes and the relationships 
between these entities. A data model is 
independent of a computer system and its 
associated data structures. 

 

Database

 

A collection of data organized according to a 
conceptual structure describing the characteristics 
of the data and the relationships among their 
corresponding entities.

 

Database 
management 
system (DBMS)

 

 A set of computer programs for organizing the 
information in a database usually containing 
routines for data input, verification, storage, and 
retrieval. 



 

Defaults

 

The values or actions that would normally be 
expected to occur.

 

Demographics 

 

Statistics of birth, death, population, etc. 

 

Developable 
surface

 

A developable surface is a simple geometric 
form capable of being flattened without 
stretching. Many map projections can then be 
grouped by a particular developable surface: 
cylinder, cone, or plane.

 

Digital

 

The ability to represent data in discrete units 
or digits.

 

DLG

 

Digital Line Graph, a USGS standard output 
file format.

 

Drag

 

To hold down the mouse button while you move 
the mouse cursor on the screen.

 

Drag and drop

 

The act of dragging a file with the mouse over 
another executable file to cause some action on 
the first file. 

 

DTP 

 

Desktop Publishing.

 

Element

 

A fundamental geographical unit of information, 
such as a point, line, area, or pixel. 

 

Equal areas

 

A map projection is equal area if every part, as well 
as the whole, has the same area as the 
corresponding part on the Earth, at the same 
reduced scale. No flat map can be both equal area 
and conformal.



 

Equidistant

 

Equidistant maps show true distances only from 
the center of the projection or along a special set 
of lines. For example, an Azimuthal Equidistant 
map centered at Washington shows the correct 
distance between Washington and any other 
point on the projection. It shows the correct 
distance between Washington and San Diego 
and between Washington and Seattle. But, it 
does not show the correct distance between San 
Diego and Seattle. No flat map can be both 
equidistant and equal area.

 

FAQ 

 

Frequently Asked Questions.

 

Feature code

 

A set of characters (alpha, alpha/numeric or 
numeric) within the GIS, which uniquely identifies 
a feature class or group of features. 

 

File

 

A collection of related information that can be 
accessed by an assigned name. 

 

Filter

 

See Plug–in filters.

 

Folder

 

A storage area for files within the Macintosh OS, 
the equivalent of a DOS or UNIX directory.

 

Format

 

The way in which data is arranged for storage 
and for transmission between software 
and/or computers. 

 

FTP 

 

File Transfer Protocol.

 

Generate

 

The file format created by the Arc/Info 
Ungenerate function.



 

Geographic 
features

 

Points, lines, and areas that comprise a map.

 

Geographic 
Information 
System (GIS)

 

Any system designed for the capturing, storing, 
checking, integrating, analyzing and displaying of 
spatially referenced data about the earth. 

 

Geo–referencing

 

The delimiting of a given object, in terms of its 
spatial location on the earth’s surface or within 
some coordinate system.

 

GIR 

 

Geographic Information Retrieval.

 

GIS 

 

Geographic Information Systems. 

 

GPS 

 

Global Positioning Systems.

 

Grain

 

The frequency of vertices or points forming a line.

 

Graticule

 

The spherical coordinate system based on lines of 
latitude and longitude.

 

Great circle

 

A circle formed on the surface of a sphere by a 
plane that passes through the center of the sphere. 
The Equator, each meridian, and each other full 
circumference of the Earth forms a great circle. The 
arc of a great circle shows the shortest distance 
between points on the surface of the Earth.

 

Grid

 

A set of regularly spaced sample points or an exact 
set of reference lines over the earth’s surface. 



 

Hydrography

 

In its most general definition, hydrography is the 
description and study of seas, lakes, rivers, and 
other bodies of water with regard to: the 
measurement of flow and investigation of the 
behavior of streams; the measurement of tides and 
currents, and the surveying, sounding, and 
charting of those bodies of water (Webster’s Third 
New International Dictionary, 1993). 

 

Hypsography

 

Lines which depict the relief of the land or 
contours.

 

Icon

 

An image representing a software function or tool.

 

Import sequence

 

The order of steps required to import data.

 

JPEG

 

Joint Photographic Experts Group, is a lossy 
compression technique for raster file formats.

 

Label

 

Text used to identify a map feature.

 

LANDSAT

 

The generic name for a series of earth resource 
scanning satellites launched by the United States 
of America.

 

Latitude

 

Angular distance, expressed in degrees and 
minutes, along a meridian north or south of 
the equator.

 

Layer

 

A designated level in artwork used for storing, 
organizing and editing graphic or mapping data.

 

Legend

 

The section of the map that explains the meaning 
of the symbols used to depict graphic or 
geographical elements.



 

Legend element 

 

A legend key combined with its associated text.

 

Legend key

 

The graphic symbol used to illustrate attributes in 
a legend.

 

Longitude

 

The angular distance east or west from a standard 
meridian to another meridian on the earth’s 
surface; expressed in degrees and minutes.

 

Line

 

One of the basic geographical elements, defined 
by at least two pairs of x,y coordinates; usually too 
narrow to be an area. See also arc and vector.

 

Linear scale

 

Linear scale is the relation between a distance on a 
map and the corresponding distance on the Earth. 
Scale varies from place to place on every map. The 
degree of variation depends on the projection 
used in making the map.

 

Lossless/Lossy 

 

Lossless techniques compress image data without 
removing detail; lossy techniques compress 
images by removing detail.

 

Map anchor

 

The minimum x and y coordinates of the data files.

 

Map co–ordinates 

 

The x,y representations of ellipsoidal earth 
locations on a mapping plane.

 

Map projection

 

A map projection is a systematic representation of 
a round body such as the Earth on a flat (plane) 
surface. Each map projection has specific 
properties that make it useful for specific purposes.

 

Marquee

 

A dashed rectangle drawn with a selection tool to 
select multiple objects.



 

Meta–Data

 

Data about data typically including information 
such as currency, accuracy, and extent. 
Meta–data is typically stored in data models or 
data dictionaries.

 

Mid/Mif 

 

A file format exported from MapInfo 
GIS software.

 

NAD 

 

North American Datum.

 

Network

 

Two or more interconnected computer systems 
for implementation of specific functions or a set 
of interconnected graphic lines defining some 
spatial features.

 

Node

 

The point or intersection at which areas or lines are 
joined; endpoints of an arc.

 

NSDI 

 

National Spatial Data Infrastructure.

 

Overlay

 

A set of graphical data that can be superimposed 
on another set of graphical data through 
registration to a common coordinate system. The 
process of laying one set of digital spatial data over 
another for analysis purposes.

 

Page anchor

 

The location on the page where the map anchor is 
placed.

 

Page size 

 

The size of the drawing page.

 

Parameters

 

Variable options or choices; boundaries of 
operations or of an object.



 

PDF

 

Portable Document Format. Developed by 
Adobe, a PDF is a file type which can be used to 
cross Macintosh, Windows, DOS, and UNIX 
platforms.

 

Pixel

 

The smallest unit of information in a grid cell map 
or raster image.

 

Plug–in filter

 

A module or modules supplied separately from the 
Adobe Illustrator program, usually for creating 
special effects in artwork. The MAPublisher 
application plug–in filters are modules that enable 
the incorporation of GIS and mapping capabilities 
within the Adobe Illustrator graphics environment.

PMS Pantone Matching System. 

Point A discrete location represented by a symbol or 
label; usually too small to be displayed as an area 
or line.

Polygon Any area bounded by a straight or irregular closed 
line representing a map component or any other 
graphic feature.

Positional 
Accuracy

The degree to which a position is measured or 
depicted, relative to its correct position as 
established by either other features or by other 
accurate processes. 

PPC Power PC (as in the Power Macintosh).



Precision That which relates to the exactness of the 
operation by which the result is obtained. The 
exactness with which a value is expressed, whether 
the value be right or wrong. 

Projection The representation on a plane surface of any part 
of the surface of the earth.

Raster A regular grid of cells covering an area.

Record A set of attributes relating to any entity; a set of 
related, contiguous data.

Redundancy The duplication of data in a database.

Render To cause to be or to become, to draw.

Resolution The number of dots per inch displayed on screen 
or printed to an output device.

Rhumb line A line on the surface of the Earth cutting all 
meridians at the same angle. A rhumb line shows 
true direction. Parallels and meridians, which also 
maintain constant true directions, may be 
considered special cases of the rhumb line. A 
rhumb line is a straight line on a Mercator 
projection. A straight rhumb line does not show 
the shortest distance between points unless the 
points are on the Equator or on the same meridian.

RS Remote Sensing. 

Rubber sheeting The transformation of spatial data to stretch or 
compress them to fit with other data.



SAIF Spatial Archive and Interchange Format. SAIF is a 
Canadian Draft National Standard for Geomatics 
data interchange. It is a specification for data 
which includes an object–oriented data model and 
a language for describing both spatial and non–
spatial data. 

Scale The relation between the size of an object on a 
map and its size in the real world.

Scanner A device for converting images from maps or 
photographs of part of the real world into digital 
form automatically.

SDTS Spatial Data Transfer Standard.

SEA Self Extracting Archive, a file compression format 
for reducing the size of large files for archival 
or transfer.

Sliver A gap formed when two lines which should be 
contiguous are slightly separated in a graphical 
representation or map.

Spatial Of space, a two or three dimensional position 
in space.

Sphere co–
ordinates

x, y locations on the ellipsoidal earth, usually 
expressed in degrees and minutes.

SPOT An earth resource satellite with high resolution 
sensors launched by France in January 1986.

Static graphic files Unchanging and non–editable graphic files.



Thematic map A map displaying selected kinds of information 
relating to specific themes, such as soil, 
land–use etc.

TIFF Tagged Image File Format, a common {raster} 
graphic file format.

Tile A discrete part of the earth’s surface. By splitting a 
study area into tiles, considerable savings in access 
times and improvements in system performance 
can be achieved.

Topographic map A map showing natural and man–made features as 
well as relief, often in the form of contours.

Topology The way in which geographic features relate to 
each other. 

Toponym The place names of a region or map feature.

Transform The process of changing the scale, projection, or 
orientation of a mapped image.

TRIM Terrain Resource Information Management.

Unix A general–purpose, multi–user computer 
operating system.

URL Universal Resource Locators. 

USGS United States Geological Survey. 

UTM Universal Transverse Mercator.



Vertices Points representing spatial x,y co–ordinates that 
occur along an arc between the nodes and help 
define the shape of the arc.

Vectors Linework or artwork. See lines and arcs.

WWW World Wide Web.

Zone Any well defined region of more or less 
beltlike form.

Zoom To magnify or reduce the current view of 
a document.
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